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1. Σκοποί ενότητας 

Στην παρούσα ενότητα δίνονται οι βασικές εντολές για τη σχεδίαση και την εισαγωγή 

σχεδιαστικών αντικειμένων (Line, Polyline) στην επιφάνεια και το αρχείο σχεδίασης. 

Δίνεται μία βήμα προς βήμα προσέγγιση στην εκμάθηση των εντολών για την παραγωγή 
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ενός τελικού σχεδίου και την ολοκλήρωση μιας πλήρους απόδοσης ενός σχεδίου 

κάτοψης κτηρίου. 

2. Περιεχόμενα ενότητας 

Πρακτικές σχεδίασης, εκμάθηση εντολών σχεδίασης μέσα από παραδείγματα  
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3. Βασικές εντολές σχεδίασης και μεταβολής σχεδιαστικών 

αντικειμένων 

3.1 Μια “βήμα προς βήμα” εκμάθηση των εντολών σχεδίασης και 

μεταβολής σχεδιαστικών αντικειμένων  

Η εκμάθηση των εντολών σχεδίασης είναι περισσότερο εύκολο να γίνει μέσα από παραδείγματα. Σκοπός 
του παρόντος κεφαλαίου είναι η χρήση των περισσότερο κοινών εντολών σχεδιασμού για την εκκίνηση και 
αποπεράτωση ενός τυπικού σχεδίου αποτύπωσης (μιας κάτοψης και μιας όψης) ενός μικρού χώρου. 
Υποθέτουμε ότι στα χέρια μας υπάρχουν μετρήσεις από την αποτύπωση ενός χώρου το σκαρίφημα του 
οποίου δίνεται στην εικόνα 1.  

 

Εικόνα 1. Drafting Settings (Snap/Grid) 

3.2 Εντολή POLYLINE 

Για την αποπεράτωση του παραπάνω σχεδίου θα δοθούν περισσότερες από μια λύσεις-εντολές. Όλες οι 

λύσεις που θα δοθούν οδηγούν στο ίδιο αποτέλεσμα. Ωστόσο, κάποιες από τις λύσεις εμφανίζουν 

ορισμένα πλεονεκτήματα και μπορεί να εφαρμοστούν για την υλοποίηση συγκεκριμένων λειτουργιών που 

αφορούν την περαιτέρω λειτουργικότητα και επεκτασιμότητα των γραμμών σχεδίασης. Θα αναλυθούν οι 

θετικές και αρνητικές επιπτώσεις στην εφαρμογή των διαφορετικών εντολών σχεδίασης και θα 

αναφερθούν αν όχι όλες αρκετές από τις διαφορετικές παραμέτρους/επιλογές των εντολών. Είναι 

σημαντικό να τονιστεί ότι η ακρίβεια στη σχεδίαση των γραμμών παίζει σημαντικότατο ρόλο. Θα πρέπει 

κάθε φορά ο χειριστής του προγράμματος να ελέγχει ότι η θέση εκκίνησης και τέλους μιας γραμμής ή 

τοποθέτηση κάθε άλλου βασικού ή σύνθετου σχεδιαστικού αντικειμένου είναι η σωστή. Αυτό 

επιτυγχάνεται με τη χρήση των ρυθμίσεων (osnap, ortho, grid-snap) στη σχεδίαση ή με τον καθορισμό της 

θέσης με χρήση ενός ζεύγους (ή τριάδας) συντεταγμένων στην ερώτηση του Η/Υ (Specify xxxxx point:).  
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3.3 1η προσέγγιση λύσης 

Ο πιο απλό τρόπος για την σχεδίαση του σχήματος της εικόνας 1 είναι με τη χρήση της εντολής γραμμής 

δίνοντας με ακρίβεια τη θέση αρχής και τέλους κάθε γραμμής του κλειστού πολυγωνικού σχήματος του 

χώρου που αποτυπώθηκε. Αν θεωρήσουμε ότι η σχεδίαση της κάτοψης του χώρου που αποτυπώθηκε 

δίνεται με βάση τη θέση του οικοπέδου στο σχέδιο πόλης που βρίσκεται το κτήριο μας, θα πρέπει να 

ξεκινήσει η σχεδίασή μας με βάση ένα γνωστό σημείο του κτηρίου, πχ. η κάτω αριστερή γωνία του, το 

σημείο δηλαδή της τομής της οριζόντιας ακμής μήκους 1m και της κατακόρυφης μήκους 3m.  

 

Θεωρούμε λοιπόν ότι η θέση που ορίστηκε παραπάνω είναι σε απόλυτες συντεταγμένες στo καρτεσιανό 

σύστημα συντεταγμένων στο AutoCAD: 17.32,18.56. Ενεργοποιείται η εντολή σχεδίασης μιας πολυγραμμής 

(polyline) και δίνεται το πρώτο σημείο εκκίνησης της πρώτης γραμμής στην ερώτηση που εμφανίζεται στη 

γραμμή εντολών Specify start point: ως ζευγάρι των παραπάνω τιμών 17.32,18.56. Επιλέχθηκε η εντολή 

polyline για τη σχεδίαση του χώρου για ένα λόγο που θα γίνει κατανοητός στη συνέχεια. Θα μπορούσε να 

χρησιμοποιηθεί η εντολή line (γραμμή). Το αποτέλεσμα οπτικά θα ήταν το ίδιο. Δεν διαφέρει (για την 

υλοποίηση της συγκεκριμένης σχεδίασης) ο τρόπος καθορισμού των σημείων σχεδίασης ανάμεσα στις δύο 

εντολές (line και polyline). Ένα σημαντικό σημείο διαφοροποίησης των δύο πολυγωνικών γραμμών είναι 

ότι η polyline ορίζει ένα ενιαίο σύνθετο σχεδιαστικό αντικείμενο ενώ η σχεδίαση μέσω της line ορίζει κάθε 

ευθύγραμμο τμήμα ως ξεχωριστή οντότητα. 

Εφόσον δοθεί το σημείο εκκίνησης της polyline o Η/Υ ζητά το επόμενο σημείο. Γνωρίζοντας ότι το επόμενο 

σημείο (πχ. το σημείο τομής των γραμμών μήκους 1m προς τα δεξιά του πρώτου σημείου που έχει δοθεί) 

απέχει 1m κατά Χ και 0 κατά Υ εύκολα δίνεται το επόμενο σημείο ως ζευγάρι συντεταγμένων 18.32,18.56. 

Με την ίδια λογικά προσθαφαιρώντας αποστάσεις σε δοσμένες συντεταγμένες μπορούμε να καταλήξουμε 

στο σχεδίαση όλων των κορυφών του πολυγώνου που υλοποιεί το χώρο. Σε περίπτωση που κάποιο σημείο 

δοθεί λάθος μπορούμε να το αναιρέσουμε δίνοντας την επιλογή U (Undo) και  (Enter). Επίσης, εφόσον η 

σχεδίαση έχει ξεκινήσει από γνωστό σημείο
1
 μπορούμε να μη δώσουμε τις συντεταγμένες τέλους του 

τελευταίου σημείου που συμπίπτει με το πρώτο αλλά να δώσουμε την επιλογή C (Close) και  (Enter). 

Πιθανή ακύρωση της εντολής πριν τον τερματισμό της στο πρώτο σημείο (17.32,18.56) και ενεργοποίηση 

της από άλλη ενδιάμεση θέση του σχήματος ακυρώνει τη λειτουργικότητα της εντολής C (Close). Αναλυτικά 

δίνονται παρακάτω οι εντολές που θα πρέπει να δοθούν από το πληκτρολόγιο για την περάτωση της 

σχεδίασης ως μιας polyline του σχεδίου της εικόνας 1. 

 

 

 

 

                                                      
1
 Εναλλακτικά θα μπορούσαμε να ενεργοποιήσουμε μια από τις παρακάτω πιθανές παραμέτρους της 

εντολής (Arc/Close/Halfwidth/Length/Undo/Width). Προς το παρών δε θα δοθούν εξηγήσεις όλων των 
εναλλακτικών υποπεριπτώσεων/παραμέτρων της polyline.  

Σημείωση: Οι τιμές των μετρημένων αποστάσεων που δίνονται στο AutoCAD για την 
αποτύπωση ενός χώρου δίνονται σε κλίμακα 1:1. Δηλαδή, εάν έχει μετρηθεί ένα μήκος 
1m το πρώτο από το δεύτερο σημείο που ορίζουν το σημείο στο AutoCAD θα πρέπει να 
απέχουν ακριβώς 1m. Όπως λέμε, στο AutoCAD η σχεδίαση γίνεται σε πραγματικές 
διαστάσεις και η εκτύπωση μόνο γίνεται υπό κλίμακα. 
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3.4 2η προσέγγιση λύσης 

Σε περίπτωση που η εκκίνηση της σχεδίασης της κάτοψης του παραπάνω σχεδίου δεν έχει συγκεκριμένη 

αρχή (δηλ. Η κάτω δεξιά γωνία του κτηρίου έχει αυθαίρετη αρχή που ορίζεται πχ. από το σχήμα του 

οικοπέδου του κτηρίου) μπορούμε να εκτελεσουμε τις εντολές σχεδίασης με τέτοι τρόπο ώστε το σχήμα 

του κτηρίου να παραμένει το ιδιο. Στην περίπτωση αυτή θα δοθούν οι συντεταγμένες της κάτω δεξιά 

γωνίας του κτηρίου με πάτημα του αριστερού πλήκτρου του ποντικιού ζε τυχαία θέση όταν ζητηθεί το 

πρώτο σημείο σχεδίασης από την εντολή polyline (Specify first point:). Τα επόμενα σημεία θα δοθούν σε 

σχέση με το αμέσως προηγούμενο σημείο. Έτσι όταν το πρόγραμμα ζητήσει το δεύτερο σημείο ο χρήστης 

θα το δώσει πληκτρολογώντας τις Σχετικές Καρτεσιανές Συντεταγμένες που είναι ένα ζευγάρι αριθμών 

στην γραμμή εντολών που ακολουθούν το σύμβολο @. Εφόσον το δεύτερο σημείο απέχει 1 μέτρο κατά Χ 

και 0 κατά Υ, θα δοθεί η θέση με την εντολή (@1,0). Συνολικά για τη σχεδίαση όλων των κορυφών της 

κάτοψης του κτηρίου θα δοθούν οι εντολές: 

 

Η σχεδίαση με χρήση σχετικών συντεταγμένων είναι πολύ βολική και ακολουθείται από τους 

περισσότερους χρήστες εφόσον είναι ευκολότερο να δωθούν οι σχετικές μετρήσεις-αποστάσεις 

χαρακτηριστικών σημείων στην κάτοψη ενός χώρου παρά να υπολογιστούν οι καρτεσιανές συντεταγμένες 

τους κάνοντας προσθαφαιρέσεις στις αρχικές συντεταγμένες των αποστάσεων που μετρήθηκαν 

παράλληλα προς τους δύο άξονες. 

Specify start point: (ορισμός του πρώτου σημείου με πάτημα του αριστερού 

πλήκτρου σε τυχαία θέσης στην επιφάνεια εργασίας) 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @1,0 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @0,1 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @4,0 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @0,4 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @-5,0 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): C ή @(0,-3) 

Σημείωση: Πολλές εντολές διαθέτουν (εφόσον ενεργοποιηθούν) κάποιες εναλλακτικές 
εκτελέσεις ή υποπεριπτώσεις. Οι διαφορετικές παράμετροι εκτέλεσης των εντολών 
δίνονται συνήθως μέσω του πρώτου χαρακτήρα που εμφανίζεται μάλιστα με κεφαλαίο 
γράμμα. Αν κάποιες παράμετροι έχουν κοινό το πρώτο γράμμα τους δίνεται και 
δεύτερος ή τρίτος κοκ χαρακτήρας για τη διαφοροποίηση των παραμέτρων. 

Command: line
Specify start point: 17.32,18.56 
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 
18.32,18.56 
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 
18.32,17.56 
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 
22.32,17.56 
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 
22.32,21.56 
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 
17.32,21.56 
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): C 
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Ένας άλλος τρόπος να οριστεί ένα σημείο σε σχέση με ένα προηγούμενο (ήδη γνωστό σημείο) είναι να 

μετρηθεί εκτός από την απόσταση και η γωνία διεύθυνσης (η γωνία που σχηματίζει η ευθεία που ενώνει τα 

δύο σημεία με τον οριζόντιο άξονα των Χ). Στην περίπτωση μας η γωνία αυτή είναι 90, 0,-90(ή 270) και 180 

μοίρες. Έτσι το ίδιο σχήμα θα μπορούσε να προέλθει με την εισαγωγή των παρακάτω εντολών και των 

Σχετικών Πολικών Συντεταγμένων όπως ονομάζονται η απόσταση και η γωνία διεύθυνσης. Η 

διαφοροποίηση κατά την εισαγωγή τους από τις καρτεσιανές συντεταγμένες δίνεται με το σύμβολο “<” 

αντί του “,” για να διαχωριστές οι τιμές των τετμημένων από τις τεταγμένες.  

Οι παρακάτω εντολές οδηγούν στο ίδιο σχήμα όπως κια προηγουμενως: 

 

 

3.5 3η προσέγγιση λύσης 

 
Η λειτουργία ORTHO όπως αναφέρθηκε και στο προηγούμενο κεφάλαιο αναγκάζει την κίνηση των δείκτη 

να σχηματίζει μόνο οριζόντιες και κατακόρυφες διαδρομές στην οθόνη. Αν θεωρήσουμε δεδομένη όχι μόνο 

την παραλληλία προς τους άξονες αλλά και τη φορά του ευθύγραμμου τμήματος σύμφωνα με την 

κατεύθυνση της γραμμής που φαίνεται να σχηματίζεται από το δείκτη του ποντικιού το μόνο που 

χρειάζεται για να δημιουργηθεί μια γραμμή είναι το μήκος της. Το σχήμα της εικόνας 1 μπορεί εύκολα να 

δοθεί με τις παρακάτω εντολές: 

Specify start point: (ορισμός του πρώτου σημείου με πάτημα του αριστερού 

πλήκτρου σε τυχαία θέσης στην επιφάνεια εργασίας)  

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @1<0  

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @1<-90 (ή 

270)  

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @4<0  

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @0<90  

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): @5<180  
Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): C ή @(3<-90 ή 

3<270)  

Σημείωση: Οι πολικές συντεταγμένες μπορεί να δοθούν και κατ’ απόλυτη τιμή δηλαδή 
να ορίζουν τη θέση κάθε σημείου με απόσταση και γωνία διεύθυνσης σε σχεσή με την 
αρχή του συστήματος συντεταγμένων. Ωστόσο, δεν είναι πολύ πρακτικό για τη 
σχεδίαση ενός αρχιτεκτονικού σχήματος (πχ. της κάτοψης ενός κτηρίου). Η σχεδίαση με 
χρήση πολικών συντεταγμένων χρησιμοποιείται πάρα πολύ στην αποτύπωση 
αντικειμένων με χρήση τοπογραφικού οργάνου – Γεωδαιτικού Σταθμού (2ο θεμελιώδες 
πρόβλημα της τοπογραφία).  
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Η παραπάνω λύση είναι η βολικότερη απ’ όλες εφόσον οι αποστάσεις που έχουν μετρηθεί ανάμεσα σε 

χαρακτηστικά σημεία στην κάτοψη του χώρου είναι παράλληλες προς τους άξονες. Μπορεί ωστόσο να 

εφαρμοστεί η δεδομένη μεθοδολογία και σε περίπτωση που εκτός των αποστάσεων είναι γνωστή και η 

διεύθυνση (παρόμοια με την περίπτωση των σχετικών πολικών συντεταγμένων). Ωστόσο είναι πολύ 

δύσκολο να επιτευχθεί με χρήση της σχετικής θέσης του δείκτη του ποντικιού η επιθυμητή γωνία 

διεύθυνσης και για το λόγο αυτό είναι απαραίτητο να έχει ενεργοποιηθεί το κλείδωμα της κίνησης του 

ποντικιού σε γωνίες διεύθυνσης που είναι ακέραιες υποδιαιρέσεις των 90
ο
 (POLAR TRACKING).  

 

3.6 Εντολές ZOOM 

Οι εντολές ZOOM είναι χρήσιμες στο να επικεντρωθεί η σχεδίαση μας και να γίνεται με την απαραίτητη 

ακρίβεια στην περιοχή του σχεδίου που εργαζόμαστε αλλά και να παρουσιαστεί στο παράθυρο εργασίας 

το σύνολο των σχεδιατικών αντικειμένων ή και οποιοδήποτε επιλεγμένο τμήμα του.  

Οι εντολές μεγεθυνσης και κύλισης (του τμήματος του σχεδίου μας στο παράθυρο εργασίας) 

ενεργοποιούνται μέσω του μενού View>Zoom και View>Pan. Ακόμη μπορεί να ενεργοποιηθούν και μέσω 

των αντίστοιχων εικονιδίων στo Standard toolbar. Μάλιστα, οι εντολές zoom βρίσκονται σε μια 

αναδιπλούμενη εργαλειοθήκη (εικόνα 2).  

 

 

Εικόνα 2. Εικονίδια των εντολών zoom και pan στην Standard εργαλειοθήκη 

Επίσης, ένας πολύ πρακτικός τρόπος για την εκτέλεση των εντολων Zoom είναι μέσω του πληκτρολογίου 

και των συντομεύσεων της εντολής (Z) και των υποπεριπτώσεων της. Πχ. για την προβολή του ενεργού 

σχεδίου στο παράθυρο εργασίας με τη μέγιστη δυνατή κλίμακα αρκεί ο χειριστής να δώσει την εξής 

αλληλουχία πληκτρολογήσεων:  

Command: line 

Specify start point: 17.32,18.56 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 1 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 1 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 4 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 4 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): 5 

Specify next point (Arc/Close/Halfwidth/Length/Undo/Width): C 
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Πρόκειται για την εντολή Zoom/Extends που αποτελεί συνήθως την πρώτη εντολή που εκτελεί ο χειριστής 

του AutoCAD όταν ανοίξει προς επεξεργασία ένα αρχείο του AutoCAD.  

Αναλυτικά όλες οι υποπεριπτώσεις της εντολής Zoom είναι (πίνακας 1): 

 

Πίνακας 1. Εντολές ZOOM 

Όνομα εντολής Εικονίδιο Λειτουργία 

Zoom / All 

 
Προβάλει όλο το σχέδιο στο 
παράθυρο εργασίας (το σύνολο του 
σχεδίου ορίζεται από το μέγεθος του 
χαρτιού που καθορίστηκε κατά τη 
δημιουργία του αρχείου ηλεκτρονικής 
σχεδίασης) 

Zoom / Center 
 

Δε μεταβάλει την κλίμακα παρά μόνο 
αλλάζει το κέντρο προβολής του 
σχεδίου στο παράθυρο εργασίας 

Zoom / Dynamic 
  Δυναμικά καθορίζει την περιοχή και 

κλίμακα του σχεδίου στο παράθυρο 
εργασίας 

Zoom / Extends 

 Προβάλει το σχέδιο (μόνο τις ορατές 
γραμμές του) με τη μεγαλύτερη 
δυνατή κλίμακα στο παράθυρο 
εργασίας 

Zoom / Previous  Προβάλει την αμέσως προηγούμενη 
παρουσίαση του σχεδίου 

Zoom / Scale 
 

Αλλάζει το συντελεστή αλλαγής της 
κλίμακα του σχεδίου με την 
ενεργοποίηση των εντολών In και Out 

Zoom / In 
 Μεγενθύνει κατά ένα συντελεστή 

(που έχει οριστεί με την εντολή 
Ζοοm/Scale) την κλίμακα στο σχέδιο 

Zoom / Out 
 Σμικρύνει κατά ένα συντελεστή 

 (που έχει οριστεί με την εντολή 
Ζοοm/Scale) την κλίμακα στο σχέδιο 

Command: z 
Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: e 
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Πίνακας 1. Εντολές ZOOM 

Zoom / Window 

 
Προτρέπει την επιλογή από το 
χειριστή του προγράμματος την 
κατασκευή ενός παραθύρου που 
ορίζει την περιοχή του σχεδίου που 
θα παρουσιαστεί με τη μεγαλύτερη 
δυνατή κλίμακα στο ενεργό 
παράθυρο εργασίας. 

Zoom / Realtime 

 Μετατρέπει το δείκτη του ποντικιού 
σε ένα μεγεθυντικό φακό. Με τη 
λειτουργία drag&drop και κίνηση του 
δείκτη προς τα πάνω μεγενθύνουμε 
την περιοχή γύρω από το δείκτη του 
ποντικιού ενώ προς τα κάτω 
προκαλούμε τη σμίκρυνση του. 

Pan 

 Με τη λειτουργία drag&drop και 
κίνηση του δείκτη κυλούμε το σχέδιο 
(χωρίς να μεταβάλλεται η κλίμακα του 
στο ενεργό παράθυρο). 

 
Ακόμα με τη χρήση του κεντρικού πλήκτρου/ροδέλα κύλισης του ποντικιού επιτυγχάνουμε μια παρόμοια 

λειτουργία όπως αυτή της εντολής Zoom / Realtime και Pan. Με την κύλιση της ροδέλας προς τα 

πάνω/κάτω μεγενθύνουμε/σμικρύνουμε το σχέδιο ενω με το πάτημα του κεντρικού πλήκτρου/ροδέλας 

μπορούμε να κυλίσουμε το σχέδιο.  

3.7 Εντολή OFFSET 

Η εντολή OFFSET είναι μια από τις περισσότερο χρήσιμες εντολές μεταβολής σχεδιαστικών αντικειμένων. 

Έχει σαν αποτέλεσμα τη δημιουργία ενός νέου σχεδιαστικού αντικειμένου μετατοπισμένου παράλληλα 

προς το αρχικό κατά μία δεδομένη απόσταση. 

Καταχραστικά χρησιμοποιούμε τόσο για την OFFSET αλλά και για άλλες εντολές τον όρο «εντολές 

μεταβολής» καθώς δεν επηρεάζουν τα ήδη υπαρχοντα σχεδιαστικά αντικείμενα αλλά πολλές φορές 

επαναλαμβάνουν ή παρέχουν ελαφρώς μεταβεβλημένα σε σχέση με το πρωτότυπο, νέα σχεδιαστικά 

αντικείμενα. Έτσι, η εντολή OFFSET μπορεί να δημιουργήσει πολλαπλά παρόμοια ή τροποποιημένα 

σχεδιαστικά αντικειμένα. Τη λειτουργικότητα της εντολής θα τη δούμε σε σχέση με το τελικό σχήμα που 

θέλουμε να παράγουμε. 

Έτσι, αν επιθυμούμε να δημιουργήσουμε με μία μόνο εντολή μια polyline που θα ορίσει την εξωτερική 

γραμμή της τοιχοποιίας που έχουμε αποτυπώσει με τη χρήση της παραπάνω εντολής polyline θα 

ενεργοποιήσουμε την εντολη OFFSET. Η ενεργοποίησή της θα γίνει είτε μέσω του μενού (Modify>Offset) ή 

μέσω του εικονιδίου της στο modify toolbar  ή πληκτρολογώντας την ολόκληρη (OFFSET) ή με τη 

συντόμευσή της (O). 

Ο δείκτης του ποντικιού αποκτά το χαρακτηριστικό του σχήμα (τετραγωνάκι) και μέσω της γραμμής 

εντολών το πρόγραμμα μας προτρέπει να δώσουμε την απόσταση της παράλληλης μετατόπισης του νέου 

σχεδιαστικού ακτικειμένου σε σχέση με το προηγούμενο: 
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Συνήθως είναι γνωστή η απόσταση της παράλληλης μετατόπισης των αντικειμένων μας και δίνεται σε 

μονάδες σχεδίασης (μέτρα). Στην  παρίπτωση πχ. που είναι γνωστό το πάχος του τοίχου (πχ. 0.25m) δίνεται 

στην παραπάνω προτροπή του προγράμματος. 

Όταν δεν είναι γνωστή η απόσταση και θα πρέπει να δοθεί δυναμικά με τη χρήση του δείκτη του ποντικιού 

δίνεται αντί μιας αριθμιτικής τιμής το πρώτο γράμμα της εναλλακτικής παραμέτρου της εντολής (T - 

Through). 

Αν έχει δοθεί αριθμητικά η απόσταση της παράλληλης μετατόπισης το πρόγραμμα ζητά να επιλεγεί ένα 

σχεδιαστικό αντικείμενο : 

 

και ένα σημείο προς την πλευρά που θέλουμε να γίνει η παράλληλη μετατόπιση του σχεδιαστικού 

αντικειμένου έχει επιλεγεί : 

 

Αν δεν έχει δοθεί η απόσταση μετατόπισης αλλά επιλέχτηκε η παράμετρος για τον ορισμό δυναμικά της 

απόστασης μετατόπισης το σημείο που ορίζεται μετά την επιλογή του σχεδιαστικού αντικειμένου που θα 

επαναληφθεί με Offset ορίζει και την απόσταση της παράλληλης μετατόπισης.  

Πολλές φορές η OFFSET εκτελείται με παρόμοιο τρόπο όπως και η εντολή αντιγραφής (COPY OBJECT). Μια 

σημαντική διαφοροποίηση της που την κάνει να υπερέχει της COPY OBJECT είναι ότι δημιουργεί ένα 

τροποποιημένο σχεδιαστικό αντικείμενο-αντίγραφο του αρχικού που έχει το ίδιο σχήμα αλλά διαφορετικό 

μέγεθος που να διαφέρει σε κάθε σημείο του ακριβώς όση η απόσταση της παράλληλης μετατόπισης από 

το αρχικό σχήμα. 

Στην περίπτωσή μας που θέλουμε να κατασκευαστεί η εξωτερική γραμμή της τοιχοποιίας από την ήδη 

υπάρχουσα εσωτερική (μετρημένη κλειστή πολυγωνική γραμμή – polyline). 

Select object to offset or <exit>: 

Specify offset distance or [Through] <1.0000>:  

Specify point on side to offset:  
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Εικόνα 3.  Με τη χρήση της εντολής OFFSET και απόστασης μετατόπισης 0.25 κατορθώσαμε να 

δημιουργήσουμε με μία μόνο εντολή την εξωτερική γραμμή της τοιχοποιίας 

 

 

Εικόνα 4.  Το σχήμα της κάτοψης μετά την εκτέλεση για κάθε επιμέρους γραμμή της εντολής OFFSET 

Σημείωση: Στην περίπτωση που δημιουργείται η εσωτερική γραμμή της τοιχοποιίας με 
χρήση της εντολής line κάθε ευθύγραμμο τμήμα αποτελεί ξεχωριστό ανεξάρτητο 
σχεδιαστικό αντικείμενο και θα πρέπει για κάθε μία από τις επιμέρους γραμμές να 
εφαρμοστεί η εντολή offset (εικόνα 4). Το αποτέλεσμα και πάλι δεν είναι το επιθυμητό 
καθώς το σχήμα δεν είναι κλειστο και προκύπτουν κενά ανάμεσα στις γραμμές ή 
τμήματα που θα πρέπει να διαγραφούν.   
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3.8 Εντολή FILLET 

Πολλές φορές θέλουμε οι γραμμές που αποτελούν ένα κλειστό σχήμα να είναι μεμονομένες ώστε να 

δώσουμε σε αυτές διαφορετικά χαρακτηριστικά. Έτσι είτε τις σχεδιάζουμε με χρήση των εντολών line αντί 

για την polyline, ή εφόσον τις έχουμε σχεδιάσει ως polyline τις «σπάμε» στα επιμέρους συστατικά τους 

ευθύγραμμα-ανεξάρτητα τμήματα. Πως θα μπορέσουμε όμως να μετατρέψουμε το παραπάνω 

λανθασμένο ως προς την εξωτερική γραμμή της τοιχοποιίας σχήμα της κάτοψης του κτηρίου μας. 

Η εντολή FILLET μπορεί να αφαιρέσει ανεπιθύμητα ευθύγραμμα τμήματα που εξέχουν από το σημείο 

τομής δύο γραμμών ή μπορεί να «συμπληρώσει» τα κενά που μεσολαβούν ανάμεσα σε δύο γραμμές 

προκειμένου αυτές να επεκταθούν μέχρι το προφανές σημείο τομής τους. Επιπλέον, η εντολή μπορεί να 

δημιουργήσει ένα καμπύλο τμήμα ώστε η μετάβαση από τη μία γραμμή στην άλλη να είναι ομαλή. 

Δημιουργεί λοιπόν ένα «φιλετάρισμα» ορίζεται από την ακτίνα καμπυλότητας που θα έχει το καμπύλο 

τμήμα της ομαλής τους μετάβασης.  

Στην περίπτωση του σχήματος της εικόνας 4 που επιθυμούμε να δημιουργηθεί το σωστό σχήμα (εικόνα 3) 

θα πρέπει να εκτελεστεί η εντολή FILLET. Η εντολή ενεργοποιείται είτε μέσω του μενού (Modify>Fillet) ή 

μέσω του εικονιδίου της  από το modify toolbar ή πληκτρολογώντας το όνομα (fillet) ή τη συντόμευση 

(f) της εντολής. Εξ’ ορισμού η εντολή δημιουργεί ένα καμπύλο τμήμα της ομαλής μετάβασης του ενός 

τμήματος προς το άλλο. Αυτό επιβεβαιώνεται από τις ενεργές ρυθμίσεις της : 

 

όπως εμφανίζονται στη γραμμή εντολών του προγράμματος. 

Αν επιθυμούμε να μη δημιουργείται φιλετάρισμα θα πρέπει να οριστεί η παράμετρος radius (δίνοντας R 

μετά την ενεργοποίηση της) να θέτει 0 την αντίστοιχη ακτίνα καμπυλότητας.  

 

Η εντολή θα πρέπει να εκτελεστεί ξανά ώστε να επιλεγούν τα σχεδιαστικά αντικείμενα που είτε θα 

επεκταθούν ή θα περιοριστούν μέχρι το προφανές σημείο τομής τους.  

 
Ο δείκτης (όπως συμβαίνει σε κάθε εντολή μεταβολής) γίνεται τετραγωνάκι και οι γραμμές που 

επιλέγονται θα επεκταθούν ή θα περιοριστούν μέχρι το σημείο της προφανούς τομής τους. Επιλέγοντας 

δύο γραμμές της εξωτερικής τοιχοποίας καταφέρνουμε να παράγουμε το επιθυμητό αποτέλεσμα. Η εντολή 

FILLET εκτελείται για μια μόνο φορά και θα πρέπει επαναληφθεί για όλες τις περιπτώσεις των γραμμών της 

εξ. τοιχοποίας. Το τελικό σχήμα που θα πάρουμε είναι παρόμοιο με αυτό του σχήματος της εικόνας 4. 

Σημείωση: Ένας εύκολος τρόπος επανάληψης της προηγούμενης εντολής είναι με το 

πάτημα του πλήκτρου Enter() ή του διαστήματος (Spacebar). Ακόμη με το πάτημα 
του δεξιού πλήκτρου του ποντικιού όταν το πρόγραμμα βρίσκεται σε κατάσταση 
αναμονής (ο δείκτης του ποντικιού είναι σταυρόνημα με το τετραγωνάκι στο κέντρο 
του) εμφανίζεται ένα μενού που η πρώτη επιλογή του είναι το Repeat <last_command> 
πχ Repeat FILLET.  

Select first object or [Polyline/Radius/Trim]: r 
Specify fillet radius <10.0000>: 0 

Current settings: Mode = TRIM, Radius = 10.0000 
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Εικόνα 5.  Μετά τη χρήση της εντολής FILLET θα επιτύχουμε το επιθυημό σχήμα της κάτοψης του κτηρίου 

 

3.9 Εντολή TRIM 

Ας υποθέσουμε ότι επιθυμούμε να δημιοργήσουμε ένα άνοιγμα πλάτους 1m στην νότια πλευρά του 

κτηρίου. Θα πρέπει να ορίσουμε δύο σημεία στο σχέδιο που να ορίζουν με ακρίβεια την αρχή και το τέλος 

της πόρτας. Είναι πολύ εύκολο να δημιουργήσουμε δύο παράλληλες ευθείες γραμμές που απέχουν από 

την ανατολική γραμμής της εξ. τοιχοποιίας αντίστοιχα 0,35 και 1,35 μέτρα.  

ΠΡΟΣΟΧΗ: Όταν οι γραμμές υπερβαίνουν το σημείο τομής τους θα πρέπει να 
επιλεγούν σε σημεία τους που βρίσκονται σε εκείνο το κομμάτι της που επιθυμούμε 
να διατηρηθεί και όχι στο κομμάτι που θέλουμε να αφαιρεθεί. 
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Εικόνα 6. Με χρήση της εντολής OFFSET δημιουργούμε δύο παράλληλες μετατοπίσεις της γραμμής του 

εξωτερικού ανατολικού τοίχου σε απόσταση 0,35 και 1,35m 

Το γραμμοσκιασμένο τμήμα του σχήματος 5 αποτελεί το άνοιγμα της πόρτας και θα πρέπει να αφαιρεθούν 

οι οριζόντιες γραμμές της τοιχοποιίας πάνω και κάτω από αυτό αλλά και εκείνα τα τμήματα των γραμμών 

που δημιουργήθηκαν με την εντολή OFFSET που εκτείνονται στο εσωτερικό του κτηρίου.  

Θα πρέπει να χρησιμοποιηθεί μια εντολή που θα αφαιρεί τμήμα υπαρχόντων σχεδιαστικών αντικειμένων 

και όχι το σύνολο τους. Η εντολή αυτή είναι η TRIM (trim=κόβω στην αγγλική γλώσσα).  

Σε κανονική λειτουργια η εντολή TRIM εκτελείται σε δύο στάδια. Κατ’ αρχήν θα πρέπει να ενεργοποιηθεί η 

εντολή είτε μέσω του μενού (Modify>Trim) ή μέσω του εικονιδίου της από το modify toolbar  ή 

πληκτρολογώντας το όνομα ή τη συντόμευσή της (TRIM ή TR). Ο δείκτης του ποντικιού γίνεται τετραγωνάκι 

και προτρέπεται ο χειριστής του προγράμματος να επιλέξει στο πρώτο στάδιο της εκτέλεσης της εντολής τις 

γραμμές που αποτελούν το όριο κοπής των γραμμών που θα επιλεγούν στο δεύτερο στάδιο της εντολής. Οι 

γραμμές επιλέγονται είτε με το πάτημα του αριστερού κουμπιού του ποντικιού όταν ο δείκτης βρίσκεται 

πάνω στις γραμμές που θέλουμε να επιλεγούν ή κάνοντας χρήση των παραθύρων επιλογής (window ή 

crossing window). Οι ομάδες γραμμών που κόβουν (και επιλέγονται στο πρώτο στάδιο εκτέλεσης της 

εντολής) διαχωρίζονται από τις ομάδες που κόβονται (και επιλέγονται στο δεύτερο στάδιο εκτέλεσης της 

εντολής) με το πάτημα του πλήκτρου Enter, Spacebar ή με το πάτημα του δεξιού πλήκτρου του ποντικιού.  

 

Για την πληρέστερη παρουσίαση των εντολών που πρέπει να εκτελεστούν παρατίθεται στο πίνακα 2 μια 

σειρά από εικόνες που οδηγούν με την ενεργοποίσηση των κατάλληλων εντολών στη δημιουργία του 

ανοίγματος στο νοτιο τοίχο.  
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Πίνακας 2. Εκτέλεση των εντολών OFFSET και TRIM με σκοπό την 
κατασκευή ανοίγματος στο νότιο τοίχο του κτηρίου 

  

Εικόνα 7. Εκτέλεση της OFFSET με απόσταση 

0.35μ. 

Εικόνα 8. Εκτέλεση της OFFSET με απόσταση 

0.35μ. 

 

 

Εικόνα 9. Εκτέλεση της TRIM /επιλογή των 

γραμμών κοπής με απόσταση 0.35μ. 

Εικόνα 10. Πάτημα του δεξιού πλήκτρου του 

ποντικιού ή Enter ή Spacebar /Επιλογή των 

ευ.Τμημάτων των γραμμών που θα 

αφαιρεθούν 
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Πίνακας 2. Εκτέλεση των εντολών OFFSET και TRIM με σκοπό την 
κατασκευή ανοίγματος στο νότιο τοίχο του κτηρίου 

 

Εικόνα 11. Το τελικό αποτέλεσμα 

 


